
DiaLog Colors

This feature is accessed from the File menu.

Enables you to change the colors of DiaLog.    You can preview the changes on the little sample form.    
Select OK if you wish to implement the new colors, select Cancel to keep the colors you had before 
entering this mode.

The five selections are:

1.    Form Background        changes the background color of forms
2.    Form Foreground          changes the text of items on the form
3.    Panel Background      changes the background of 3-D panels
4.    Panel Foreground        changes the text of items in the panel
5.    Button Foreground    changes the color of the button titles

Click on one of the four buttons or directly on the form or text of the sample display.

You may also click on C1, C2, C3 and default.    The first 3 are samples.



Calendar
 
        General

        Print Address

        Print Phone

        Print Name

        Print Time

Menu
          File
 



File

            Open Appointment Book

            Delete single Day Entries

            Delete Range of Dates

            Delete all Entries

            Output Book Entries



Address Book

Brings up the page in the address book for the person currently listed on the main DiaLog display.    You 
may edit any of the entries.    If you do edit any entries, the person will no longer be present at the front 
panel.    You must make the selection again.

To obtain information about the individual fields press here.



NewTime

Set System Time

Set Alarm Clock



Input Data

Input Field Descriptions

Search Mode



Registration

Until you register, the program will be in the "unregistered" mode.    All    features are fully functional, 
except you will be limited to a 30-day free trial.

To register DiaLog, select Registration Form from the Main Help menu of DiaLog.

You may also register DiaLog through CompuServe (GO SWREG).    The ID for DiaLog for Windows is:    
853.

For credit card registration see our website on the Internet.    

After you receive your registration certificate, select File - Register Program - from the main DiaLog menu 
to actually register your copy of DiaLog.

Enter the name and registration number exactly as shown, including dashes in the registration number.



DiaLog Options

The Options menu allows you to set certain DiaLog options that will be active every time DiaLog is 
started.    To go to the Options menu select File from the main DiaLog menu and then DiaLog Options.

 Log1, 2, 3, 4
Timer Active
StayOnTop
Maximize
Log seconds
Call Timer Off
Sort Logs by Name
No Keypad
Both Speed Dialers
NoAlphaConversion
Calling Card
WorldClock Setup
Envelope Setup
Reset marked messages
Default Appt Book
Redial Delay



Main Display

Click on area you need help with:



File

            Addr Book Utils
            Phone Log Utils
            Job Code Utils
            Com Port Setup
            Change System Time
            Alarm
            Register Program
            Password
            DiaLog Options
            Change Colors
            Calendar / Apptmnt Book
            World Clock

 



Books 1, 2, 3, 4

Bring up desired address book for selection of person to be called.



View Logs

A short cut to viewing or printing any of the Log files.    See Phone Log Utils for more information.



Remarks
 
The  Remarks selection on the main DiaLog menu is a toggle control.    It alternately opens and closes a 
remarks window near the bottom of the main DiaLog display.    The window displays the Remarks data 
from the address book for the selected address book entry.



Notes

 Enables you to record, view and print notes that are available quickly from the DiaLog menu.    There is a 
note book for each address book and a general one if no name is selected.    Empty note books are not 
saved.

Pressing AllNoteBooks on the menu enables you to view any of the note books.

Pressing the Clear button will clear the notepad and place a new date and time at the top, as well as the 
name that is currently in use.

If you spend any amount of time in the notepad, it is a good idea to press Save every so often if you have 
made or are making any changes.

The Remarks Notebooks are the same as above except for the Name and Number feature.



Selection List
 
The import feature is accessible from the Addr Book Utils on the main File menu.

Select the items contained in your import file.    See the sample import file (SmplImpt.txt).    Be very careful
here, or data will end up in the wrong fields.

Hint:

Import into an empty book.    You can later copy to the desired book.    If you don't have an empty book, 
temporarily save book 4 (File - Addr Book Utils - Save Book).    Then delete book 4 (File - Addr Book Utils 
- Delete Names).    After you have imported to book 4, check the entries - if ok - copy to desired book (File
- Addr Book Utils - Copy Book).    Now delete all names in book 4 (see above) and Restore book 4 (File - 
Addr Book Utils - Restore to).



World Clock

The World Clock consists of 6 clocks with 5 of them programmable by you.    The 6th clock is always 
displaying the GMT time.    To invoke the World Clock select File - World Clock from the main DiaLog 
menu, or simply press Ctrl-W on the keyboard.

Note:    Upon installation, the World Clock is initialized for the Los Angeles time zone.    Unless you live in 
that zone, you must first adjust it for your local time.    Times are displayed according to your international 
setting in the Windows Control Panel.

Setting the clocks

Slew Control

Reset

Offsets for some Cities



Speed Dialers

The speed dialers give you quick access to often used numbers.    There are two speed dialers, so you 
could assign one for personal calls and one for business calls.

Enter the Name and Number of the person/company to be called.    If the call is to be logged, enter 1, 2, 3,
or 4 for the Log File to be used - blank if no logging.    Check Job Code if a Job Code is to be logged.

Press More to open and close Dialer 2.    To always display both speed dialers, check Both Speed Dialers 
in the DiaLog Options menu. 



DiaLog Message

Some of DiaLog messages have a feature that lets you mark them if you do not wish to see that message
again.

You may Reset this feature from the DiaLog Options menu to have the messages appear again.



Select credit card

Fill in and/or select the desired credit card.    See the instructions at the bottom of the display for 
instructions.

If you have the password feature enabled, clicking on the empty Credit Card Call selection on the main 
display will require that the password be entered.    To safeguard the calling card info again, deselect the 
Credit Card Call selection.



Calling Card and CallBack
 
What is it?

Using It



                  DiaLog          
                  A Phone Dialer and Logger

Remember - Help is always just an F1 click away
                      

Overview
Evaluating without Installing
Getting Started
Main Display
Log Incoming Calls
Quick Keys

Calling Card and CallBack

Alarm
Calendar / Apptmnt Books
World Clock

Register DiaLog
Remove DiaLog

Revisions

Disclaimer

(c) 1992-1997 AM-WOLJO Shareware, All rights reserved



Overview

· Logging of incoming and outgoing calls
· Tone or Pulse dialing.
· Manual dialing if no modem.    (All other features still functional)
· Speed Dialing of 24 numbers.
· Instant access of last 10 numbers dialed.
· 4 address books.    Empty books require no disk space.
· Calling card and call back feature.
· Up to 6 phone numbers and up to 4 email addr per entry.    Blank fields can be used for other 

purposes.
· 3 convenient pop up calendar/appointment books/diaries.
· Dials special Tone-Dial services that require additional numbers and/or digits.
· Auto-redial busy numbers.
· Accepts non-numeric phone numbers ( 1-800-Egg-Head ).    (optional)
· Easy to set the system time while calling your local time operator.
· Phone logs may contain job codes.
· Phone logs may be viewed, printed and saved to another file.
· Password protection.
· Quick notepad for each address book and one if no name selected. 
· Prints envelopes.
· Functions as a stop watch.
· Features an alarm clock.
· Programmable 6-City world clock.
· Search Address Books.
· Import Address Book data.



Getting Started

General
With Modem
Without Modem



ClientTime

Displays the local time of the person selected in the phone number display above.

To have this time displayed, enter the offset value in hours from your location to the other person.    This 
can be done at the time you are entering the person's data into the address book, or it may be added later
by selecting that person's entry in the address book and editing the phone number field (select View from 
the main menu of DiaLog).



Keyboard / Calendar

The keyboard may be used to enter phone numbers manually.

If you do not use the keyboard, you may wish to replace it with a calendar display.    Go to DiaLog Options
and select No Keyboard.    You may then double click on any date to bring up that date in the default 
appointment book.



Name Display

Displays the name selected from one of the address books.

You may also enter the name and phone number manually.    That information will then be available for 
logging.



Number Display

Displays the phone number selected from one of the address books.

You may also enter the name and phone number manually.    That information will then be available for 
logging.

To insert a number from another application, press Shift-Insert while the cursor is in the number field.



PhoneTitles

This drop-down box displays the title of one of the six phone numbers from the address book.    The usual 
entries are:    home, office, fax, etc.



CLR Key

Clears the Name and Phone Number fields for manual entries.



Dial Key

Starts the dialing process.    This key is only visible if a phone number is present in the phone number 
window.



Date Display

Displays the date according to your computer's clock.

You may double click on it to bring up the default appointment book.



Time Display

Displays your computer clock's time.

You may double click on it to set the system time.



Elapsed Time

Displays the elapsed time of your outgoing and incoming phone calls.

May also be used as a Stop Watch.



Disclaimer

DiaLog COPYRIGHT (c) 1992-1997 WOLFGANG JOHN    ALL RIGHTS RESERVED

THIS PROGRAM IS PROVIDED "AS IS" WITHOUT REPRESENTATION OR WARRANTY OF ANY 
KIND, EITHER EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION, ANY 
REPRESENTATIONS OR ENDORSEMENTS REGARDING THE USE OF, THE RESULTS OF, OR 
PERFORMANCE OF THE PROGRAM, ITS APPROPRIATENESS, ACCURACY, RELIABILITY, OR 
CURRENTNESS.    THE ENTIRE RISK AS TO THE USE OF THIS PROGRAM IS ASSUMED BY THE 
USER.    IN NO EVENT WILL THE AUTHOR OR HIS EMPLOYEES BE LIABLE FOR ANY DAMAGES, 
DIRECT, INDIRECT, INCIDENTAL OR CONSEQUENTIAL, RESULTING FROM ANY DEFECT IN THE 
PROGRAM, EVEN IF THE AUTHOR HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES.    THIS DISCLAIMER SHALL SUPERSEDE ANY VERBAL OR WRITTEN STATEMENT TO 
THE CONTRARY.    IF YOU DO NOT ACCEPT THESE TERMS YOU MUST CEASE AND DESIST 
USING THIS PROGRAM.



Addr Book Utils

                  View/Edit Books
                  Add Names
                  Delete Names
                  Search Books
                  Print Book
                  Save to File
                  Label/Export File
                  Import to Book
                  Copy Book
                  Save Book
                  Restore to . . . . .



Phone Log Utils

The Phone Log Utilities give you the ability to manage all 4 log files.    The options are:

              View Logs
              Print Logs
              Save Logs
              Delete Logs

Only calls to phone numbers that have logging enabled in the address book, will be logged.    While in the 
phone log you can make any changes    you wish to the file.    Select File - Exit to leave the phone log 
display.    Do NOT minimize the log display to an icon, exit instead.

DiaLog provides you with two versions of a log file.    One is called Normal, and the other Extended.    
These modes are selected under DiaLog Options from the File menu.    All 4 logs can be configured 
independently.    In the Normal mode DiaLog logs Date, Time, Name, Phone Number, Minutes and Job 
Code.    In the Extended mode Company, City, State and Purpose of Call are added.    Under DiaLog 
Options you may also set your own titles for the log reports.



Alarm

Set and Clear alarm time.    Use the alarm clock to alert you with a message or with music from a program
like our CD Player.

QuickKeys:

Ctrl-M  to set the message mode
Ctrl-F    to set the CD player mode
Ctrl-Q    to clear (cancel) the alarm
Double click on alarm icon to shut it off

CD Player mode:

This mode requests the address of our CD player MyCDplayer.
The default is:    c:\mycd\mycd.exe /play shuffle

Other sample command lines for our MyCDplayer program:

c:\mycd\mycd.exe /play
c:\mycd\mycd.exe /play program
c:\mycd\mycd.exe /play rptdsk
c:\mycd\mycd.exe /play track04
c:\mycd\mycd.exe /play e: shuffle              ; The drive letter works in Win95 Only (we think!)

Note:    You may of course execute any program that makes sense to you.    Just enter its full path.



Password

The password feature is accessed from the File menu on the main DiaLog display, or you may double 
click on the password status line at the bottom of the main display.

Enables you to set or clear the DiaLog Password.    

Once a password has been assigned, it is not possible to enter DiaLog either on initial load, or 
after it has been reduced to an icon.

The password also protects the credit card calling and CallBack services features.

There are 2 ways to recover from a lost password.    If your copy of DiaLog is registered, use the method 
listed on your registration certificate.    The second method requires the deletion of the address book file 
"DialLst1.dat" in the DiaLog directory (this will cause all entries to be lost).

Set Password

Allows you to set or change the DiaLog password.    The password is case insensitive, therefore either 
upper or lower case may be used.

Clear Password

Allows you to clear the DiaLog password.    You may also clear it by double clicking on the password 
status line.



Calendar General

Displays one of 3 convenient appointment calendars/diaries.    You may double-click the date on the main 
display of DiaLog to easily bring up the calendar.    In DiaLog Options you can set the default calendar.    It 
is the one that will be loaded automatically.    From the calendar File menu you can bring up the other 
ones, but the default remains until you change it.    Empty books require no storage on your system.

You enter (edit, delete, select, copy etc.) text as with any other Windows editor, such as Notepad.    Once 
you enter text into the day's notepad, that day will be highlighted in red on the calendar as soon as you 
leave that date.    Delete the text and the highlight will disappear.

Click on any day to bring up the notepad for that day.

Click on the scroll bar arrows to change the month - click in the area between the arrows to change the 
year.    You may also drag the center knob to change many years at once.

DO NOT manipulate the appointment book files directly, they must remain unaltered.

Hint:

Double click on the front panel date to bring up the calendar.



Calendar Print

Prints Time, Name, Address and Phone Number of the address book selection.    If no selection is active, 
only the Print Time button is enabled.



Delete Range of Dates

Select Range of Dates to be deleted.    Click on the calendar for either the start or end date as instructed 
on the panel.    Select Delete to delete the data.



Our Web Site

You will find information about our shareware programs on our web site on the Internet.    The programs 
may be down loaded there and registered via credit card.    In addition you will find other useful 
information, such as links to other sites.

Point your browser to:    http://www.fix.net/~wjohn



Output Book Entries

Enables you to output appt book entries to the Windows Write program, from where you can print or 
otherwise manipulate them.    It is also a method of finding out what forgotten items are still taking up 
space in your book.    The data is currently in a temp file which will be deleted, therefore you must save 
the data in another file if you wish to keep it.

Select Entire Book and Output to output the entire book.

Select Range of Dates to output a range of dates only.    Then click on the calendar for either the start or 
end date as instructed on the panel.    Select Output to output the data.

Note:

In the interest of speed and program size, the size of each appointment book is currently set to approx. 
32,000 characters.    You will be told when you are getting close.    A later version of DiaLog (after 
Windows 95) will overcome this limitation.    (You will most likely never reach that limit!)



Delete single day

Deletes the entries for the selected day.



Open Appt Book

Open one of the three appointment books.    The default book (set in DiaLog Options) is opened 
automatically.



Delete All Entries

Deletes all entries in the entire appointment book.



JobCode

A short code that identifies the call with a particular task for you.    It will appear with the call in the log file.



Start General

Remember - Help is always just an F1 click away

By now you should have read the Overview section. 

To get familiar with the controls on the main DiaLog display you should take a look at the Main display 
Help information.

To get started with DiaLog, enter a few names and numbers into one of the address books.    You do this 
by selecting File - Addr Book Utils and then Add Name from the main DiaLog menu.    

You can also select your own titles for the log files.    See DiaLog Options for more information.

Now read the information on Getting Started With Modem or Without Modem.    Before you do however, 
you may wish to set your logging options.    Select DiaLog Options from the File menu for more 
information.



Without Modem

Although the DiaLog program is best used with a modem, it is still very useful, even if you do not have a 
modem.    You can use the address books, you can bring up numbers from the address books for manual 
dialing, you can use the Touch Tone Services feature, you can take advantage of the non-numeric 
characters ability, and you can log any of the calls whose numbers are in the address books. 

Your status in the lower portion of the display should indicate that no modem is present.    If the status 
says Modem off line, then you have selected a modem port with the ComPort Setup mode.    Otherwise 
the program will behave as outlined under With Modem.

Note:    The CallBack feature is not suitable for non-modem use.



With Modem

Preliminary
Placing a Call
After the Call



Touch Tone

Touch Tone Services:

(Note:    DiaLog is intended for VOICE services only.)

The general procedure with these type of services is to dial the phone number and when the phone is 
being answered, you are told to enter a series of numbers to identify yourself and your account.    More 
numbers and terminators are required to get to the area of interest.    The following number is an example 
of such a number combination:

 1-800-123-4567            111-22-3333*4444*1*3*2*

Where the first 11 digits are the phone number to call the service.    The second set of numbers 
represents the special digits to be dialed once a connection has been established.    This second set of 
numbers should be keyed into the Special" field of the address book entry.

If the service does not accept all digits at once, separate them as many times as you want by placing a 
Tilde (~) character after each group.    In the sample case above, the code works as is for evening calls.    
In daytime, one additional digit is required to switch the system into the automated mode.    The Service 
would not accept that digit together with the rest of them - it required a slight delay.    This is how the 
number worked:

    1*~111-22-3333*4444*1*3*2*

Notice the Tilde character after the switching digit with its terminator.    You can have one Tilde character 
after each group of digits.    If the delay created by the Tilde character is not sufficient for the particular 
service you are calling, enter the following string somewhere in the Remarks field:    Tilde=3    This will add
3 seconds to the default delay.    The number can be between 1 and 9 inclusive.

While testing this program with modems from three different manufacturers, it was found that one of them 
did not function properly in the Special Mode.    It was necessary to set the "Pre-Modem Setup" field of the
'Modem Setup' mode to AT X3, even so the other two ran with the default of X4.

Dialing a number with a "Special" field is essentially the same as dialing a regular number.    You select 
the number from the address book and press 'Dial'.    As soon as the phone is being answered, press 
'Connected' to cause the rest of the digits to be dialed automatically.



Alpha conversion

DiaLog will automatically convert alphanumeric numbers    ( 1-800-Egg-Head ).

This feature can be disabled for the entire program from the DiaLog Options menu, or on an individual 
number basis by preceding the number with a tilde (~) character (~461-3090).



ComPort Setup

This menu is reached from the main display File - ComPort Setup menu, or by Ctrl-P.

ComPort
Tone or Pulse
Redial Volume
Prefix
Pre-Modem Setup
Post-Modem Setup



ComPort

Select the ComPort your modem is connected to, or select No Modem.

Be sure to select the proper port number of the modem.    If you are not sure, do NOT guess, or you may 
hang up your modem, or even your computer.



Tone-Pulse

Select Tone or Pulse dialing.    

If you select pulse dialing, then you must not lift the receiver until dialing is completed.



Redial Volume

Under Comport Setup set Redial Vol Hi to the highest volume your modem can handle (usually 3 [1 or 2 if
3 is too high]) - this enables the Redial mode - set it to 0 to disable Redial.    

Set Lo to the lowest volume you want the modem to be when not in Redial mode (usually 0-3).

Once you receive a busy signal, hang up the phone until it is being answered.    You may set the wait 
interval between redials from the DiaLog Options menu.    During long redial delays, press the Esc key to 
cancel the redial.

To test the Auto-Redial-On-Busy mode, simply call the number your modem is connected to.

Note:    With some internal modems it may be difficult to hear the busy tone.    The only solution to that 
would be to listen to the busy tone on the phone and hang up before the redial starts.



Modem Prefix

If your system requires a "9" (or any other digit) to get an outside line, enter 9 in PreFix.    Enter a W after 
the 9 if the 9 results in a dial tone.    The W causes the modem to wait for that dial tone.



Pre-Post Modem Setup

Use the modem setup fields for any optional data, such as adjusting the speaker volume.    The Pre 
command is sent before dialing and the Post command after dialing.    Normally these should be left 
blank.    See your modem manual for AT commands.

Example Speaker Volume command:    ATL1



Stop Key

The Stop button serves 2 purposes.    If the Timer was started with the Start button, then pressing Stop 
merely stops the Timer and gives you a chance to log a manually placed call.

If the Timer was started automatically by the dialing process,    then pressing the Stop button stops the 
Timer and initiates    the logging process.    If the number you called also had the logging of job code 
enabled in its address book entry, the program will prompt you to select a job code from your job code list.

After using the modem, it is always a good idea to make sure the phone is properly hung up (on-hook).



With Modem Preliminary

Note:    It is possible to get a modem "hung up".    The easiest way for this to happen is a conflict between 
2 or more devices trying to use the same COM Port, such as a modem and a mouse.    If you suspect the 
modem may be hung up, get out of all your programs until you get back to the DOS prompt.    Sometimes 
just getting out of Windows will reset your modem, but more often than not, you must RESET your 
computer or recycle its power from on-to off-to on.    A soft reset Ctrl-Alt-Del will NOT clear the modem.    If
the hang-up persists, you probably have a conflict problem - check your hardware and documentation.
    
If you have a Hayes compatible modem that is properly installed and configured, you are ready to dial 
numbers with the DiaLog program.    Be sure you know which COM Port your modem is connected to.    If 
you have not yet done so, select File - ComPort Setup from the main DiaLog menu and set up your 
modem parameters.    (If this is your first attempt at using the DiaLog program, you may want to practice 
using the program in the Without Modem mode.)

Once your modem is properly set up, you are ready to dial your first number.    (You may find calling the 
local time service a good way to check out the program.)    Your status in the lower portion of the display 
should indicate that the modem is present and off line and which port it is connected to.    If the status 
says No Modem, then you have not selected a modem port with the ComPort Setup mode.



Placing a call

There are 3 ways to place a call from within DiaLog.    You can key in the number directly, use the Speed 
Dialer, or get the number from one of the address books.    To obtain a number from one of the address 
books, select the desired book from the main menu and then select the name you wish to call.    Once the 
number appears in the phone number window, you merely press Dial (or Enter) to start the dialing 
process.

The modem status will change to "Modem Dialing", and you should hear the modem dialing.    Another 
screen will pop over the main DiaLog display and advise you to lift the receiver and press the Connected 
button once your call is being answered.    You may also cancel the call at this time by pressing the 
Cancel button.    Pressing the Connected button will display Call in Progress and start the timer.

When you are finished with your call, press the Stop button to stop the timer.    This will change the status 
from Call in Progress to No Call in Progress.    It will also cause the program to initiate the call logging 
process if it is enabled in your address book for this name.    In addition, if you also enabled Job Code, the
program will ask you to pick a Job Code from the Job Code table.    (For the latter to happen, you must 
have created a Job Code log by selecting File and Job Code from the main menu, otherwise you will be 
told that no Job Code file exists.)



After the Call

You now have made your first call with DiaLog.    If anything went wrong, please retrace your steps and 
see if you did everything as outlined in the previous instructions.    If you have a need to call numbers that 
require you to enter special codes once a recorded voice answers the phone, read the information under 
Touch Tone Services.

If the number you called had logging enabled in your address book, you may now take a look at the 
telephone log.    Press Lg on the main DiaLog menu, or select File - View Phone Logs from the main 
DiaLog menu.

You should    take the time to read about the rest of the features of the DiaLog program.



Quick Keys

You may double-click on:

    Name Display to bring up the address book page for the selected name

    Date Display to bring up the default appointment book

    Time Display to change the System time

    Small Calendar    (in place of keyboard) to bring up the default appointment book for the selected date

    Alarm Clock    to turn it off if it is active

    Modem Status Line    to bring up the ComPort Setup menu

    Password Status lines to enter / change the password

    City labels of the World Clock to bring up the World Clock setup menu

Insert Data:

You may insert a phone number you obtained from another application by pressing Shift-Insert while the 
cursor is in the phone number field.



Log1, 2, 3, 4

Each address book enters information into its own log.

There are two types of logs - Normal and Extended.

The Normal log format lists Date, Time, Name, Phone Number, Minutes and Job Code.    The Extended 
format adds Company, City, State and Purpose of Call.    You will be prompted to input the Purpose of the 
call after the call is completed if the Extended format is in effect for the address book the call was made 
from.    The extended mode requires a LaserJet printer capable of printing Landscape (horizontal) mode.

The new logging options will not take effect until a new log is started, which means the old one has to be 
deleted (Select Delete Logs from the Phone Log Utilities.



Timer Active

The Timer Active feature - if set to On - will cause a beep at the end of each period set in the Seconds 
field.    This will remind you that the timer is still running in case you forgot to Stop it after the end of your 
call.



StayOnTop

The StayOnTop feature - if selected - will cause the minimized icon to stay on top of any application under
Win3.x.



Maximize

The option Maximize - if set - will cause DiaLog to come up in normal display.    If the option is cleared, the
program will come up as an icon on the task bar.    This is useful if you have included DiaLog as one of 
your startup files.



Log seconds

This option - if selected - will cause the log file to record the time of the call in minutes and seconds.

The first 59 seconds will be rounded to 1 minute.



Call Timer Off

This option - if selected - will not start the call timer while you are making a call.

Note:    Calls will NOT be logged if this option is selected.



Sort Logs    by Name

Log files are by default sorted by date and time.    Select Sort Logs by Name to sort them by name.



No Keypad

If this option is selected the Keyboard will be replaced by a small calendar.    You may double click on a 
date on this calendar to bring up the default appointment book for the same date.



Both Speed Dialers

If selected, will bring up DiaLog with both speed dialer showing.



Default Appt Book

From the DiaLog Options menu select the appointment book that will come up by default.    The others 
can still be accessed from the File menu of the appointment book / calendar display, but that will not 
change the default.



Redial Delay

Enter the number of seconds to wait before redialing.



Reset marked messages

Some of DiaLog messages have a feature that lets you mark them if you do not wish to see that message
again.    This reset feature resets all the marked messages so they will be displayed again.



Setting the clocks

The World Clock displays 6 locations, 5 of which are programmable by you.    To make any changes to the
clock settings, go to DiaLog Options and click on World Clock Setup.    You may also simply double-click 
on any City label on the clock.

All settings are based on London (G.M.T.) time.    We use Los Angeles in California, USA as an example.   
Checking a world time chart, Los Angeles is 8 hours West of London.    Therefore we enter -8 into the 
offset location next to the Los Angeles title.    (Had we wanted Germany, we would have entered Germany
as the title.    Germany is 1 hour East of London, therefore we enter 1 into the offset.)    Repeat this 
procedure for any other location you wish to change.    Just remember, going East from London, numbers 
are positive, going West they are negative.

Next we must set the offset from London to our location.    Since we are in Los Angeles, we enter -8 into 
the last box.

Be sure to press Set when done, and again press Set after getting back to the DiaLog Options menu.

The Los Angeles clock now displays your computer clock time and you can see the local time of all the 
other selected locations.

To program a location that is not an even hour from London, like New Delhi, proceed as above, but since 
New Delhi is 5 hours and 30 minutes East of London, enter 5.5 next to the New Delhi title.    Only 30 
minute locations can be handled in that fashion.



Slew Control

Use this control to temporarily slew to other times to perform what if lookups.    (What time must I call my 
customer in Tokyo to reach her/him at noon?)    Press Reset to return to your local time.



NoAlphaConversion

By default DiaLog converts alpha characters ( 1-800-Egg-Head ) to numeric values.

If NoAlphaConversion is checked, then the conversion from alpha to numeric does not take place.



Calling Card and CallBack

What is it?

The Calling Card and CallBack feature enables you to dial additional digits every time you make a call as 
with credit card calls and the new long distance and overseas services.    International Callback is a 
technology which enables Service providers to offer their worldwide members lower rates on their 
international calls originating outside of the US.

How does it work?

The Calling Card and CallBack feature have the following thing in common:    They both require extra 
digits to be dialed.    They may require a wait for a dial tone and they may also require a call back to the 
service provider.    These extra digits can be before or after (or both) the actual number you are calling.

How does DiaLog figure in?

To use the CallBack Services requires many digits to be entered - make a mistake, start over!

With DiaLog you enter the information once.    After that you simply enable the Calling Card feature, select
the party you wish to call and press Dial.    DiaLog has room for 6 different Calling Card / CallBack entries.

Using Calling Card and CallBack



Using Calling Card and CallBack

In order to use the Calling Card and CallBack feature, it must be enabled under DiaLog Options.

Once it is enabled, a display "Calling Card" appears on the main DiaLog display.    Clicking on this display 
opens up a window where up to 6 different providers can be programmed.

The display contains a samples window which gives a few examples.    Essentially you decide whether the
additional digits are dialed before or after (or both) your main number.

Click on the area below for help on any field.

  
 



Envelope Setup

Selecting Env while in one of the address books enables you to print envelopes.    The default is set for 
4.125 x 9.5 in, or 10.6 x 24.1 cm envelopes.    For other sizes select Envelope Setup from the DiaLog 
Options menu.    Top Left-X and Top Left-Y refer to the horizontal and vertical distances to the top left 
corner of the return address and delivery address    of the envelope respectively.    Depending on your 
printer, you may have to practice with blank paper first in order to get the hang of it.

_______________________________
                        | *x,y             |

|             |
| *x,y                                     |
|                                     |
|             |
|             |
|______________________________ |

 The first time you print an envelope, you must select the return address from one of the address books.    
To use your own name, it must be in a book.    The system will remember the address, unless you delete 
names in the address book where the return address is located.    In that case the return address memory 
will be cleared.



Offsets for some Cities

Offsets from G.M.T. for some world cities:

(If your location is on daylight savings time and the other is not, you must adjust the other location by one 
hour.)

Africa-South, Johannesburg ... 2
Alaska, Anchorage .............. -9
Argentina, Buenos Aires ...... -3
Australia, Perth .................... 8
Australia, Sydney ............... 10
Bangladesh, Dacca .............. 6
Brazil, Rio De Janeiro .......... -3
Canada, Toronto ................. -5
China, Beijing ...................... 8
Egypt, Cairo ........................ 2
Finland, Helsinki .................. 2
France, Paris ...................... 1
Germany, Berlin .................. 1
Hawaii, Honolulu ............... -10
Hong Kong .......................... 8
India, New Delhi .................. 5.5
Indonesia, Jakarta ............... 7
Italy, Rome ......................... 1
Japan, Tokyo ...................... 9
Kenya, Nairobi .................... 3
New Zealand, Wellington .... 12
Newfoundland .................... -3.5
Nigeria, Lagos .................... 1
Pakistan, Karachi ............... 5
Peru, Lima ........................ -5
Russia, Moscow ................. 3
Saudi Arabia, Riyadh .......... 3
Solomon Islands ............... 11
Thailand, Bangkok .............. 7
United Arab E., Dubayy ...... 4
USA, Chicago, IL .............. -6
USA, Denver, CO .............. -7
USA, Los Angeles, CA ...... -8
USA, New York, NY........... -5
Venezuela, Caracas .......... -4
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Main Help

      Contents      Displays the Contents window of the DiaLog Help file

      Registration Form    Displays the DiaLog registration form

      Version Changes      Displays the changes that have been made to DiaLog

      About      Displays the customary About form



Name

The address book will be indexed by the name entered here.    It may either be an individual's name, or a 
company.    If the Name is that of a person, enter it last name first (Smith, Bill), because that is how it will 
be sorted in the address book.    This entry may be up to 25 characters long.



Phone Input

Enter up to 6 phone numbers (up to 35 characters each) and their titles (home, office, fax, etc.).

Always enter the full phone number, including the country code and area code.

The Country Code box is used for CallBack Services only.    It must be added here and with the full phone 
number.

In the Time Offset box enter the time difference in hours between your location and the person you are 
calling.    This will cause the Client Time to be displayed.

See Touch Tone Services for special Touch Tone Services.    

To enter additional numbers for the same name, create a new entry in the address book with some 
change in the name field. (You will be unable to access the second record if the name is exactly the 
same.)

The phone numbers may contain non-numeric characters as in 1-800-Egg-Head. Click here to find out 
how to disable that feature.    Dashes are optional (they count as chars), but they make the numbers more
readable.

Use unused Phone fields for anything else you like.



Company

Enter up to 35 characters.



Address field

Enter up to 30 characters in each address field.



City field

Enter up to 30 characters.



State

Enter the 2-character State code, or up to 20 characters province, etc.



Zip field

enter the postal zip code, up to 10 characters.



Country field

Enter up to 20 characters.



Email field

Enter the email address, up to 50 characters.

You may enter anything else here.



Special

Up to 40 characters of a special number.    See Touch Tone Services for more information.      

May be used for other purposes, but the first character must be a colon (:) in that case.



Remarks

Enter up to 40 characters, or ~filename (~sample) to use a file for your remarks.    Do not include an 
extension to the file name.



Logging

Select this option if you DO want the calls logged for this address book entry.



Job Code

Selecting Job Codes lets you create a job code file, or add and delete entries in an existing one.    Job 
Codes may be up to 12 characters long.

Select this option if you DO want a job code logged with this entry.    If you do mark it, you should create a 
job code file. This enables the system to prompt you to select a job code once the call is completed.    
Select File - Job Code Utils - Add from the main DiaLog menu to create the job code file.

DiaLog lets you log job codes along with the other logged information for each call.    These job codes are 
obtained from the job code file at the time the call is being logged, which is right after you press the Stop 
button on the DiaLog main display.    You will only be prompted to select one of the job codes, if Job 
Codes is enabled in the address book for the phone number you are calling.    

    



Input Field Description

Enter information into the address books.    As a minimum you must enter the Name. 

Name
Phone
Company
Address 1, 2
City
State
Zip
Country
Email
Special
Remarks
Logging
Job Code
Envelope



Search Mode

Will search the selected address book for the desired data.    More than one field may have search data.    
The search data may be a partial string - no wild cards.    

To find non-blank fields, enter: ~* into the desired field.

To find blank fields, enter: ~= into the desired field.

Any matching records will be placed into address Book4.    If Book4 is not empty, the data in it will be 
saved temporarily.    The data in Book4 may now be manipulated with all the address book utilities.    
Book4 cannot be searched because it is used to store searched data.



View/Edit Books

Access the address books to look up information, make changes to existing entries, or print envelopes.    
Use Add Name and Delete Name to add or delete names from the address books.

For information about the individual fields, see Input Fields Description.



Save Book

This feature is intended to permit the temporary saving of one of the address books.    The book so saved,
can now be manipulated in any way without effecting the original data.    It is best to restore the original 
book as soon as possible, before you forget about its contents.

Save Books differs from Copy Books in that the first saves the entire book to a temporary book, while the 
latter permits selective copying of names from / to any of the four books.

Note:

Before manipulating any address book data, be sure you have backed up files of the address books.    
They are DialLstx.dat, where x = 1 to 4.



Restore to

Restores the temporary book saved with the Save Book feature to any book .

Note:

Before manipulating any address book data, be sure you have backed up files of the address books.    
They are DialLstx.dat, where x = 1 to 4.



Print Book

Provides ability to print selected fields of all entries in the address book.    To print selected names, first 
copy them to an empty address book.    (See Copy Book.)



Save to File

Same as Print Book, except the output goes to a file and blank lines are not printed.



Copy Book

Provides the ability to copy any number of entries from one book to another.    Duplicate names will be 
flagged.



Label/Export File

Creates file suitable for creating address labels with programs such as WinWord.    Individual fields are 
separated by tabs.



Incoming Calls

To time and log incoming calls, press the Timer's Start button as you receive the call and then press the 
Stop button when the call is finished.    You will be given a choice to select the Name from one of your 
phone books, or to key it in manually.



System Time

Provides you with an easy way to change your computer's time.    (You can also double-click on the main 
time display.)

Hint:

Call your local Time service first and while the Press Button when Connected window is present, press 
the Ctrl-T key combination.    This brings up the Set Time feature.    



Status Lines

No Call in Progress / Call in Progress

Changes from No Call in Progress to Call in Progress after the call is established by pressing the 
Connected button.    The Elapsed Time counter is started at that time unless Call Timer Off has been 
selected from the DiaLog Options menu.

No Modem / Modem offline (COMn) / Modem Dialing

Changes from No Modem to Modem offline (COMn) once a ComPort is selected from the ComPort Setup 
menu.

Changes from Modem offline (COMn) to Modem dialing once the Dial button, or a selection from the 
Speed Dialer is pressed.

No Password Protection / Password active

Changes from No Password Protection to Password active once a password has been entered from the 
File - Password menu on the main DiaLog display.    You may also double click the password status line.



Remove DiaLog

1.    Simply delete all files in the DiaLog directory.
2.    Remove the DiaLog directory.
3.    Remove the DiaLog icon from the Program Group
4.    Remove the Program Group if it is only for DiaLog
5.    DiaLog did NOT change any of your files such as Win.ini etc.
6.    DiaLog added the following files to your Windows\System directory:
        VBRUN300.DLL, MSAFINX.DLL, CSCALNDR.VBX, CSSPIN.VBX, CURTIME.VBX and 
THREED.VBX.
        You may delete any of them if you are sure they are not used by
        other applications.    (Best to save them on diskette for a while!)



Job Code Utilities

The Job Code Utilities give you the ability to manage the Job Code file.    The options are:

            View Job Codes
 
            Add Job Codes
 
            Delete Job Codes



Revisions

- 3.5.0      26 Jan 97

1.    Changed to Windows Help file.

2.    Increased some of the field lengths in the address books.

3.    Added CallBack ability to Calling Card feature.

4.    Added "Last 10" feature.

5.    Alpha conversion of phone number now optional.

6.    Added a Client Time display.

7.    While in Notebooks, all other Notebooks may now be viewed.

8.    Added 3 samples to Change Color mode.

- 3.4.9.1    6 Sep 96

1.    You may now double-click on the keyboard replacement calendar and end up in the main Calendar 
program with the same date.

- 3.4.9      18 Jun 96

1.    Version 3.4.8 introduced a problem with certain versions of Win3.1.    It caused the sort feature of the 
Speed Dialer to set all names to the first entry.

- 3.4.8      10 Jun 96

1.    If the calendar was accessed while on Speed Dialer call, the name and phone number would be lost 
once the calendar was exited.

2.    Added Speed Dialer sorting.

3.    Remember last credit card setup.

- 3.4.7      21 May 96

Version 3.4.6 introduced a major bug which prevented the Speed Dialer data from being saved.

- 3.4.6      15 May 96

Added CD player call to alarm clock

- 3.4.5      17 Apr 96

1.    Fixed bug in Speed Dialer mode.    It brought up the manual form after the call.

- 3.4.4      21 Mar 96

1.    Fixed bug in Credit Card mode.    Credit card mode would remain active after de-selecting it.



- 3.4.3      15 Feb 96

1.    Fixed bug in Speed Dialer logging mode which caused the logging to fail under certain conditions.

- 3.4.2      3 Feb 96

1.    Bug in 3.4.1 caused program to fail upon upgrade if "maximized" was not set in DiaLog Options.

- 3.4.1      2 Feb 96

1.    Added 'More' button to Remarks field.

- 3.4.0      1 Feb 96

1.    Side-by-side Speed Dialers (See DiaLog Options)

2.    Calls entered manually may now be logged.

3.    The Remarks field of the address books may now be expanded to a file.

4.    To prevent a character conversion on a phone number, precede the number by a tilde character.

- 3.3.2.1    6 Aug 95

1.    Modified JobCode file handling to permit adding new job codes "on the fly".

- 3.3.2    25 Jul 95

1.    Doubled number of speed dialer entries

- 3.3.1.1    6/29/95

1.    Fixed potential problem if in Special mode and logging is enabled and no additional digits are entered 
from the keyboard.

- 3.3.1    6/8/95

1.    Fixed a problem that caused DiaLog to fail if the Short International Date Setting in Control Panel was
set to 10 digits (06/08/1995).    The failure occurred at the time the Stop button was pressed when logging 
was enabled.

- 3.3.0.2    6/1/95

1.    Program failed to go into Edit mode if the Job Code box on the 12th speed dialer entry was enabled.

2.    Added reset buttons to the 'Change System Time' feature.

- 3.3.0.1    5/27/95

1.    The appointment book printout added the letter N to the beginning of the printout.

2.    The return address message may now also be prevented from displaying.

- 3.3.0      5/22/95



1.    Made adjustments for Win95.

2.    Added Speed Dialing.

3.    Added incoming call timing and logging

4.    System Time may now be set by calling the local time service and while the 'Press Button when 
Connected' display is active, pressing the Ctrl-T key combination.

5.    The keyboard now remains active in "Special" dialing mode.

6.    Fixed bug in Import mode.

7.    Sorting Phone Logs by Name is now an option in 'DiaLog Options'.

8.    Fixed bug in 'Add Name' which sometimes caused data to appear in a BBS field when none was 
entered.

9.    The main keypad may now be replaced with a calendar by selecting 'NoKeypad' in DiaLog Options.

10.    The 'Envelope Printing' mode now has its own setup in 'DiaLog Options'.

11.    Some messages may now be prevented from being displayed.

- 3.2.10      4/10/95

1.    Added "Disable Call Timer" feature to the DiaLog Options menu.

2.    More than one character may now be entered when selecting name from book.

- 3.2.9        3/15/95

1.    Added Print capability to the Notepad feature.

- 3.2.8        3/6/95

1.    Modified address book conversion program to handle 4 books, in case someone modifies from the 
latest DOS version.

2.    There was a bug in "Add Name" mode.    If entering more than one name, the previous BBS entry did 
not get cleared.

- 3.2.7        2/13/95

1.    Enabled phone number and BBS-ID search in book search mode.

- 3.2.6        1/23/95

1.    Renamed the appointment book files from DialDatn.dat to Apptdatn.dat, where n = 1, 2, or 3.    This 
enables them to be compatible with the program "MyCDplayer" by this author, if the DiaLog and 
MyCDplayer programs are placed into the same directory.

- 3.2.5        1/16/95



1.    An accidental mailing of some version 3.2.4 disks introduced a bad bug.    If the calendar was exited 
via the exit button or the menu File Exit, all data in the appointment book was lost.    Exiting from the 
upper left corner control box worked alright.    All version 3.2.4 dated 1 Jan 95 and before did NOT have 
this bug.

- 3.2.4        1/1/95

1.    The telephone titles (home, office, Fax) next to the phone number on the main display are not visible 
with the default colors - only after colors have been changed.    This bug has been fixed.

2.    The phone logs may now be sorted by Name.

- 3.2.3        12/23/94

1.    Modified the "Log Seconds" option to round the first 59 seconds to 1 minute.

- 3.2.2        12/22/94

1.    Under the main Help menu the buttons on MyHelp display were accidentally left inoperational.    Only 
a double click worked.

- 3.2.1        12/17/94

1.    Log files are now displayed and printed using the Windows Write program.

2.    You may now set your own DiaLog colors.

3.    All forms were changed to always have the Cancel button to the left of the OK button.    (It had not 
been consistent.)

4.    You may now set a delay time between redials from the DiaLog Option menu.

5.    Fixed bug in "AddName" mode which caused an "Illegal Function" if a duplicate name was entered 
followed by a carriage return.

- 3.2.0        11/01/94

1.    Each record holds up to 6 phone numbers (Use spares for anything).

2.    Up to 4 BBS ID's    (Use spares for anything).

3.    Added one additional address field.

4.    Now has up to 4 address books.

5.    Up to 3 Convenient pop up appointment books/calendars.

6.    6-City world clock

7.    Added 'Stay-On-Top', 'Maximized' and "Log Seconds" to the DiaLog Options menu.

8.    Empty books appear dimmed on menus.



9.    You may double-click on Name, Date, Time, Modem and password status lines, and World Clock 'City'
field.

10. Program flags if you attempt to add duplicate name.

11. Phone Log uses your international time and date setting.

12. Phone number may now be up to 25 characters.

13. Feature to copy names from one phone log to another.

14. The 'Name Delete' feature now allows multiple name selections.

15. 'Quick Notes' uses international date and time.

16. 'Quick Notes' displays person's name if one is selected.

17. There now is a note book for each address book, and a general one if no name is selected.

18. Printout of selected fields from address books.

19. Uses a better functioning Spin (Prev/Next) control.

20. Ability to output selected help topics.    (Handy for your recipes)

21. Other enhancements.

- 3.1.6        9/29/94

1.    Fixed bug in main menu "Addr" feature.    If the address feature was selected and a change was made
to the data, the data change would be lost and the DiaLog program would be exited.    (Feature "View 
Addr Book" from the File menu worked just fine.)

2.    The time display window may now be double-clicked.

- 3.1.5

Cosmetic changes

- 3.1.4 -    4-19-94

1.    Added ability to access the address book from the main menu for the selected phone number and 
name.    In this mode it is not possible to move back and forth in the address book.

2.    Modified import feature to place the company name into the Name field if the Name filed is blank.

3.    Added padlock icon to password display.    This icon may be double-clicked to access password.

4.    Require verification before deleting records in Addr Books.

5.    The Com Port line may be double clicked.

- 3.04 -      1-21-94



1.    Added Address Book import feature.

- 3.03 -    12-04-93

1.    If "Hi Redial Volume" is set to 0, "Lo Redial Volume" is now used to set the modem speaker volume.    
(See ComPort Setup from the main DiaLog menu.)

2.    You may now control whether DiaLog comes up minimized or maximized.    If the second parameter in
the Command Line Parameter = max, then DiaLog comes up maximized.    The first parameter 
determines if the minimized DiaLog icon stays on top of other forms.    To stay-on-top and to come up 
maximized, the command line in the Program Manager 'File', 'Properties..' should read:    DialLog -1, max.

- 3.02 -    11-01-93

1.    Alarm clock now considers any time entered prior to the current time to be for the next day.

2.    A clear button has been provided for the Time Set and Alarm Set windows.    Each time interval (hr, 
min, sec) can be cleared individually.

3.    The "days used" for unregistered versions now counts correctly.

4.    File MSAFINX.DLL is required but not present in the Windows\System\ directory on everyone's 
computer.    It is now part of the FoneW.exe file.

- 3.0    10-24-93

1.    Converted program to run under Visual Basic 3.0.    Program now requires VBRUN300.DLL.

2.    Added alarm clock feature.

3.    Fixed minor bugs.

Version information for earlier versions has been deleted to conserve space.



Evaluating without Installing

 To evaluate DiaLog without actually installing it, simply unzip it to an empty directory and double click on 
diallog.exe.

To get rid of it, delete all files in that temporary directory.

To install, double click on install.exe and let it install to a directory other then the temp directory.    Once 
things are working, delete all files in that temporary directory.



Select

Selects the service to use.    The Access ID title will appear on the main DiaLog display.



Access ID

Enter a title that will enable you to recognize the service provider.    It will be displayed on the main DiaLog
display.



Order1

The number you enter here determines when the number in Number1 will be dialed.

A "1" will cause Number1 to be dialed first.

A "2" will cause Number1 to be dialed after the normal (phone book, speed dialer) number.



Number1

Enter the number to be dialed as determined by Order1.

The number may be followed by a "W" which will cause the program to wait for a dial tone to come back 
from the dialed number.



Delay1

Enter number of seconds to wait after Number1 has been dialed.



Order2

The number you enter here determines when the number in Number2 will be dialed.    Order1 and 
Number1 must have data in them.

A "2" will cause Number1 to be dialed first, then Number2, then the phone book or speed dialer number.

A "3" will cause Number1 to be dialed, then the phone book or speed dialer number, then Number3.



Number2

Enter the number to be dialed as determined by Order2.



Delay2

Enter number of seconds to wait after Number2 has been dialed.



Wait for CallBack

Enter "1" or "2" (no quotes) to wait for CallBack after Number1 or Number2 has been dialed.

This will cause the program to display a window that tells you to press Continue after you have answered 
the phone and determined it is indeed a CallBack.    If it is not, press Cancel.

If you pressed Continue, the program will now dial the number from your phone book or Speed Dialer.



Slew Name

Enables you to slew through the selected address book.



LastTen

Remembers the last 10 numbers you called from the address books, or manual entries.    Speed dialer 
calls are not remembered here, because it is just as easy to press a speed dial button.



Delete Names

Enables you to delete names from any of the address books.    Never delete the book itself.






